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Notice:

Elliott Data Systems Inc. reserves the right to make improvements or changes in the products
described in this manual at any time without notice.

While reasonable efforts have been made in the preparation of this document to insure its
accuracy, Elliott Data assumes no liability resulting from any errors or omissions in this
document, or from the use of information contained herein.

Copyright Notice:

This manual is copyrighted. All rights reserved. This manual may be printed for use by licensed
IDPix/IDPix 1000 users only. This manual may not be reproduced for distribution outside a
licensed site.

Copyright © 2011 Elliott Data Systems Inc.
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Installing IDPix 1.1.6

1. Locate the installation file, IDPix.exe version 1.1.6 and Run As Administrator.

B DPix.ex Ao san)
|
- Open

'&' Run as administrator
Troubleshoot compatibility

F.  Scanforwviruses
@ WinMerge
Send to 4

Cut

Copy

Create shortcut
Delete

Rename

Properties

2. Click Next and accept all prompts.

F B
1) [DPix - InstallShield Wizard ==

Welcome to the InstallShield Wizard for IDPix

The InstallShield(R) Wizard will allow you to modify, repair, or
remove IDPix, To continue, dick Mext.

< Back [ Next > ] [ Cancel ]
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Configuring IDPix 1000 Professional

Approved Cameras

The IDPix 1000 Professional software has been approved to work with the following cameras:

ValCam (Model: 1ISG-Z100)

Videology (24C7.38USB-L38)

Videology with Flash (24C7.38USB-F-L8)
Videology with Flash 5mp (24C708AF)
Microsoft LifeCam Cinema

Setting IDPix 1000 Professional Settings

From the START menu select All Programs, Elliott Data Systems, IDPix, configure IDPix.

§u Uatacara Lara Printers
1. Elliott AUTOCam
.. Elliott Data Systems
| IDPix
&1 Configure IDPIX Help and Support
IDPIX Manual
&3 Test IDPIX

1., Games

Devices and Printers

Default Programs

. Maintenance

4  Back

Confidential 12/05/2013 6
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Select the camera from the dropdown list.

Select Configure
5 conrs core .l

| File Help

—Choose Camera: I

t IWebcam ;I Configure |

—Capture Mode:
= Auto (take snapshot immediately without live video)

£ Manual (show live video preview and allow user to click capture)

—Crop Mede:
" Manual (operator crops photo using crop and adjust editor)
@ Juto (photo autematically cropped)

|+ Proof cropped photo with options to manually crop

—Percent of entire picture that face region should take:
1
0% 100%
—Face ¥
1
: . ¢ ‘ :
low default high

—Auto-Crop Failure Action:
' Manual crop photo

™ Cancel photo capture

—D Proportion: esizing:
width: [FI
Height: IE’.DD— Resizer Settings |
Concd |

Camera Configuration Settings:

e Choose Camera — specifies which type of camera IDPix will use to take photos.

e Capture Mode — specifies whether a live preview will be shown before photo is captured.

e Crop Mode — specifies whether the subject will be automatically cropped from the
picture.

e Proof Cropped Photo - specifies after auto cropping whether a window showing the
cropped photo will be displayed before the photo is returned to the 3™ party application.

o Percent of Entire Picture that Face Region should take — specifies how tight the auto
crop feature will crop to face.

e Auto-Crop Failure Action — specifies what action to take if the auto crop feature cannot
recognize a face with the camera feed.

e Destination Proportions — specifies the aspect ratio for the captured photo.

When you have completed making the desired camera settings, click Save.

Confidential 12/05/2013 7
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Configuring Camera Specific Settings
Some of the approved cameras have settings that apply only to one camera.

Access settings that apply to all cameras from the Live Preview window click the File menu then
click Configure or from the START menu select All Programs, Elliott Data Systems, IDPix,
configure IDPiX.

Select the camera from the dropdown in the Choose Camera section.

To the right of the Choose Camera section click Configure.

r ™Y
2 e Cortion O e

| File Help

—Choose Camera: il

i Webcam LI Configure |

—Capture Mode:
" Buto (take snapshot immediately without live video)

= Manual (show live video preview and allow user to click capture)

—Crop Mode:
" Manual (operator crops photo using crop and adjust editor)
' Pusto (photo automatically cropped)

¥ Proof cropped photo with options to manually crop

— Percent of entire picture that face region should take:
1
? .
30% 100%

— Face recognition sensitivity:
1

J
low default high
— Auto-Crop Failure Action:
" Manual crop photo
" Cancel photo capture
—Destination Proportion: Resizing:
Width: [E]
Height ISDD— Resizer Setlings |
Concel |

Each camera will have its own specific settings. Below is the configuration screen for the
cameras.

Confidential 12/05/2013 8
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Microsoft LifeCam Cinema
%1 Configure Webcam ‘u M

—Choose Webcam:

IMicmsoﬁ LifeCam Cinema LI Cancel I Save I

S = —

Videology Camera
&1 Configure Videology —— M!

[

[T
i -

Bl

Cancel |[ Save |

When you have completed configuring camera settings, click Save.
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Videology Camera with Flash
Go to Start, Programs and open the Videology Viewer software.

Select the Camera Settings from the dropdown. You should see the following screen.

Video Capture Filter Properties

24C13 Properties | 24C13 Zoom/Pan Propeties |

— Parameters - Backlight Compensation

Shutter Speed: I v] ¥ Enable backlight compensation

e Redgion width:
boaGC <l ‘ IB C8 O w12 O Rl
l— Gamma correction Hegion height:

I Minor (left to right] Majos fresy O C 14 12 C Rl
¢ BOHz

I Flip [top to bottom)  B0Hz

Region position:
4 I Pl

Saturation:

—White Balance

Mode: |Auto (fancy) él
Red:

Blue:

- Edge Enhancement

V On v21115
hw: 0.1.0.7

Depending on the light in the room, you may have to adjust the Backlight Compensation area
to read from % to full. Select Apply and OK to exit.

Setup and Tips for the Videology are found on the Videology driver CD.
There is a flash intensity knob on the side of the camera. Turn the lens to focus the camera.

Tip: If you run into any issues with the Videology camera, you can do a factory reset inside of the
Viewer software. You will then unplug the camera and plug it back in.

Confidential 12/05/2013 10
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Installing Videology 5 MegaPixel Camera Drivers

1. Insert Videology CD that came with the Videology 5MP camera.

2. When AutoPlay comes up, click Open folder to view files.

-

g PutoPlay

[

(Mobﬂe Solutions™

By Elliott Data Systems, Inc.

DVD RW Drive (E)
SFT-15003-Rev_1.

General cptions

¥

Import pictures and videos
using Dropbox

L

Open folder to view files
using Windows Explorer

View more AutoPlay options in Control Panel

3. Double-click Setup.msi to run setup program.

o
= Recent Places

4| Libraries
I @ Documents
> Jzﬁ Music
I [ Pictures
> B# Videos

Pyl Computer
&, Local Disk (C3)
I* 5 Ghost (D:)

I gy MICHAEL J (H:)

[ 5 mjolly (\192.168.1.2\Archive) (O:)
I» 5 Developrment (\\edsstl_filesnd) (Q:)
I 5 Clients (\\192.168.1.2) (R:)

=] mJoIIy (\\192 168.1.24Users) (U:)

A3

1 item selected

& &4 DVD RW Drive (E:) SFT-15003-Rev_1.

=N
— - *
OU Q_, + Computer » DVD RW Drive (E:) SFT-15003-Rev_1. > | % S=Gm’| DVD RW Dnv=|: ‘Sr 15003-... P |
T — = aaaas =
Organize ¥ Burn to disc =~ 0 @
45 Favorites MName Date modified Type
P Desktop 4 Files Currently on the Disc (1)
% Downloads [i5 setupmsi 2/11/201510:08 AM_ Windows Instal
%# Dropbox

4 Files Ready to Be Written to the Disc (1)

desktop.ini 8/6/2012 8:29 AM

[» 58 All_Projects_Source (\WINSTALLSHIELDZ) (I:)

Configuration s

5
4, Click Next.
Confidential

12/05/2013
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w = b
1 Camera viewer N - —

Welcome to the Camera Viewer Setup Wizard

The inztaller will guide pou through the stepe reguired to inztall Videology Camera View o pour
campLter.

WARMIMG: This computer program iz protected by copynght law and international reaties.
Unauthorized duplication or distribution of thiz program, or any portion of i, may result in severe civil
ar criminal penalties, and will be prozecuted ta the masimun extent pozsible under the law.

5. Click Next.

Yo T Y ol

Select Installation Folder

The installer will inztall Camera Yiewer to the following folder.

To install in this falder, click "Mexst". Taoinstall to a different folder, enter it below ar click "Browse".

Ealder:
C:\Program Files [=86)\ideologyhCameralizwer', [ Browse... ]

[ Disk Cost._ ]

Install Camera Viewer for yourself, or for anyone who uses this computer:

(@) Everyone

(70 Just me

Cancel ] ’ ¢ Back ] [ Pt > ]

6. Click Next.

Confidential 12/05/2013 12
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Foeo N T - e

Confirm Installation

The inztaller iz ready to inztall Camera Yiewer o pour computer.

Click "Mext" to start the installation.

Cancel l ’ < Back ] [ Mest > ]

7. Click Close.
| ™
Pore SN T % - =

Installation Complete

Camera Yiewer haz been succezsfully instaled.

Click "'Cloge’ to exit.

8. Plug in Videology 5MP camera. After a short time you should see this screen.

Confidential 12/05/2013 13
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_ Driver Software Installatior X

Your device is ready to use

USB Compaosite Device J Ready to use
Videclogy SMPiel Cam J Ready to use
Videclogy 5SMPixel Cam J Ready to use

Configuring IDPix to Use Videology 5 MegaPixel Camera

1. Inthe Start Menu locate and open Configure IDPIX.

Control Panel >
‘@ Configure IDPIX

» Al Programs

l |Search programs and fites

2. Inthe Choose Camera dropdown, choose Webcam.

File  Help

—Choose Camera:

Webcam LI Configure
Valcam |

- J‘u"ldeolngy
PLoTE TV

" Auto (take snapshot immediately without live video)

& Manual (show live video preview and allow user to click capture)

—Crop Mode:
™ Manual (operator crops photo using crop and adjust editor)
{* Auto (photo automatically cropped)
¥ Proof cropped phato with options to manually crop
1~ Percent of entire picture that face region should take: ——

3. If you do not get a popup, click to Configure the Webcam settings.

Confidential 12/05/2013 14
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—Choose Camera:
Webcam j Configure

—Capture Mode:
" Auto (take snapshot immediately without live video)

& Manizl (=how live viden nreview and allow vser o click cantrs)

4. Under Choose Webcam, select Videology 5MPixel Cam, then click Save.

i Configure Webcam u

— Choose \Webcam:

(Choose camera)

Videology 5MPixel Cam

5. Click Save.

Confidential 12/05/2013 15
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—Choose Camera:

Webcam ;I Configure |

—Capture Mode:
{~ futo (take snapshot immediately without live video)

= Manual (show live video preview and allow user to click capture)

—Crop Mode:
" Manual (operater crops photo using crop and adjust editor)
{* Luto (photo automatically cropped)

¥ Proof cropped photo with options to manually crop
—Percent of entire picture that face region should take:

0% 100%

—Face recognition sensitivity:

I
/

low default high i
—Auto-Crop Failure Action:
]
% Manual crop photo
" Cancel photo capture |
N
—Destination Proportion: ——— Resizing:

Vafidth: IZ{H]
Height ISDH— Resizer Sethngs |

Qam:ell

You have successfully Installed IDPix 1.1.6, the SMP Videology Drivers, and Configured IDPix
to use your new 5MP Videology camera.

Confidential 12/05/2013 16
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Valcam (AutoCam)

Tip: Please do the initial set up for the Auto Cam (Start, programs, AutoCam) Prior to setting up
inside IDPix 1000 Professional.

Open Auto Cam program.

Select Auto White Adjust in lower right corner.

& VALCam USB

Live Brightness

Subiject Distance

pati

r~Use Flash |
---- % Flash Off

| © FlashOn |

1~ Preview Capture -
 No

 Yes

Auto White Adjust

CAPTURE | Adjust

Place white paper in front of subject’s face.

While holding paper in front of subject’s face, click the OK button until you hear the pc beep.

Accurate White Balance @

* 1.Paosition white or gray object in front of camera
‘\l) 2.Zoom in 50 white objects is atleast 1/4 of screen size.
3.Click OK and wait fFor beep to remove white object

OK

The camera’s white balance is now set.

Note: To get optimal quality, place white paper as close to where the subject will be positioned. Make
sure paper covers %2 of the screen.

Confidential 12/05/2013 17
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Valcam (AutoCam) Inside of IDPix
@ contgureveca_ . =

—Live Exposure: -

O
darker

Internal Flash:
|off

Flash Intensity
|36t

‘white Balance:

l Flourescent

Adjust the Live Exposure as needed.
Adjust the Zoom.

Note: For best auto crop results, make sure zoom is set correctly.

Turn Internal Flash ON or OFF accordingly.

If flash is used, set Flash Intensity to match distance from camera to subject.
When settings are completed, select Finished.

On the Camera Configuration screen, click Save.

Confidential 12/05/2013 18
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Configuring IDPix Inside Third Party Software

Datacard ID Centre

Open ID Centre Designer.
Open the ID Centre project that you want to use the IDPix 1000 Professional capturing

software.

Select View the Production form.
Click the Photo Field, select the Source tab.

General | Source |Operator Promptl StoragelAdvanced

Default Photo Source:

IDPix 1000 Professnonal

Photo from File

Tru Photo camera
TWAIN

TWAIN (Fast)

Video for Windows
Video for Windows (Fast)

Select the IDPix 1000 Professional from the dropdown.
Click OK

Click the File menu then Save Project.

[T v—

‘File | Edit View Insert Format Tools Windoy
New Project... Ctri+N
Open Project... Ctrl+O
Close Project
Save Project Ctrl+S
Save Project As...

Confidential 12/05/2013 19
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Mobile Solutions Preferences and Settings

Elliott Data Mobile Solutions (EEMS)

Log in to EEMS and Open Preferences and Settings

Click Preferences and Settings button.

Event Manager Mobile Solution T Mobile Solutions

Add / Edit Personnel
Groups and Alerting -
Preferences and Settings
[ Forms & Reportiny

TogaedOvaed Assets —

Click System Settings button.

| Custom taming llDatabase Connection and Patns setup il Back |

Select Program Preferences.
Select System Settings.

Elliott Data Mobile Solutions (Mobile ID 1.0)

Log in.
Select Preferences and Settings. 1. Click Preferences and Settings button.

Mobile Solu,

Add / Edit Personnel

Report Viewer 2. Click System Settings button.

[ Custom aning J|_Database Connection and Paths Setup | Back |

Select Program Preferences.
Select System Settings.

3. Slide mouse over to left to expand Quick Nav

Confidential 12/05/2013 20
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—=——=sssmm=== 2 Click Configure IDPix button to
open the IDPix configuration.

Cortigure 1DPx | Covt———rosResze [l Resize Photos)

W Enzble Handheld Dy

Corfigure Badging

parter 0P [

ons

EEMSWEB .COM W Hitps

Dataserver:

eemsweb com M Hitps

Select configure IDPix.

&1 Camera Configuration

File Help

Choose Camera:
‘Webcam v] ‘ Configure

Capture Mode:
Auto ftake snapshot immediately without live video)

© Manual (show live video preview and allow user to click capture)

Crop Mode:
Manual (operator crops photo using crop and adjust editor)

© Auto (photo automatically cropped)
V| Proof cropped photo with options to manually crop
Percent of entire picture that face region should take:
U
30% 100%
Auto-Crop Failure Action:

@ Manual crop photo
Cancel photo capture

Destination Proportion:
Width: 200
Height: 300

[ Cancel | [ save |

Select the camera from the dropdown list.
Follow the configuration procedures on page 4 for your specific camera

Select Save and Exit to save and return to the previous page

Confidential 12/05/2013 21
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Licensing IDPix

When opening ID Centre for the first time after installing IDPix 1000 Professional, you will get
the following screen.

,

Please enter your license string below:

You will then enter the Product key that was sent to you for the installation.
The licensor will attempt to connect and automatically license the software. If the licensor

connects, the screen will close and the software has been licensed.

If the Licensor cannot connect, you will see the following screen.

T
I
Flease enter your license string below:
[22222 - [22622 - [73212 - [22222 - [22222
Submit |
Flease call the soft f: to lete your li
Manufacturer: Elliott Data Systems
Support Line:  (636) - 386 - 8400
Serial #:
A B C D E F ,
22222 - 22622 - 73212 - 22222 - 22222 - 22322
Confirmation #:
A B c D E F G
Cancel | Submit |

Please contact Elliott support at 1-888-345-8511 to have the software manually licensed.
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Using IDPix

Basic Capturing
Launch IDPix from 3™ party application.
Move subject into view of camera (preferably with a backdrop).

If IDPix 1000 Professional is configured to have a Capture Mode of Manual you will see the live
preview of the subject like the below screen.

Once the subject is in place, click Capture.

b

"E2 Live Preview

File Help

| Capture I

If IDPix 1000 Professional is configured to have a Crop Mode of Auto and the Proof setting is
enabled you will see a Crop Proof screen that will allow you to proof the captured and cropped
photo before passing the picture onto the 3" party software.

Confidential 12/05/2013 23
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‘%4 Crop Proof (=34

Cancel | Retake | Manual Crop | Adjust [[ Ok |

To accept the photo as displayed, click OK.

If you wish to adjust the auto cropping of the captured photo, click Manual Crop. For
further details see “Manual Cropping of Captured Photo”

If you wish to adjust the brightness if the captured photo, click Adjust. For further
details see “Adjusting the Brightness of Captured Photo”

If you wish to retake the picture again, click Retake.

Once you accept the captured photo, IDPix 1000 Professional will close and the picture will be
displayed in the 3" party application.
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Manual Cropping of Captured Photo
Capture an image then click Manual Crop.
Drag the yellow selection rectangle over the desired subject.

Resize the yellow selection rectangle to the desired size to encompass the entire subject by
clicking the black corner of the rectangle while dragging to the desired size.

Once done adjusting the crop region, click OK.

52 Manual-crop Proof =
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Adjusting the Brightness of Captured Photo

Capture an image then click Adjust.

&1 Crop Proof ==

Cancel | Retake | Manual Crop | [ Adiust| Ok |

Click the picture with the preferred brightness.

Click image with best brightness.
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Accessing Help from within IDPix

From the Live Preview screen or the Camera Configuration screen, click the Help menu, and
then click Manual.

The IDPix manual will display in your default PDF viewer.
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